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In addition to the individual program manuals, you will find basic explanations on the operation of the
programs on our homepage www.frilo.com in the Campus-download-section.
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Application options

The HTM+ program is suitable for the calculation of single-span and multi-span timber beams.
A cantilever beam can also be selected as a special case.

Cross-sections can be different, with haunch, multi-part, with reinforcement. Spans can be divided into
sections, joints are also possible.

The superposition and the design are performed automatically.

The program is designed for a graphically supported interactive workflow.

DIN EN 1995
ONORM EN 1995
NTC EN 1995

BS EN 1995

PN EN 1995

EN 1995

The data necessary to define a simple basic system can be entered via the assistant. Subsequently, you can
easily modify and supplement this basic system via the interactive graphic user interface.

You can define supports in the z-direction and for the torsion about the y-axis (with the HTM-2 add-on, you can
also define supports for biaxial loading in the y-direction). In each case, you can optionally define rigid
supports or the enter a spring value. A column settlement can be pre-set for the individual supports.
Alternatively, also the spring values of a single column that can be defined underneath and/or above the beam
can be calculated by the program and then be used for the beam calculation.

For the stability verification (HTM-S add-on), the fixed restraints can be defined on the cross-section. A
distinction is made between the position of the fixed restraints in the longitudinal direction of the beam and
their position on the cross-section.

Load types: uniformly distributed, trapezoidal, triangular, concentrated loads and concentrated moments.

Loads can be converted into area loads via the design specification "per beam" and the definition of a beam

spacing. 5
Connected
programs
Three-dimensional frame RSX+ (alternative calculation) ‘B RSX+ Framework
Multi-span beam BTM+ / STM+ / HTM+ / HNV+ (alternative calculation) | Bl BYM:Contmious Bearm Reinfosced Concrete

| STM+ Continuous Beam Stesl

Forwarding of the bearing loads to the support programs B5+, STS+ and
HO1+ as well as TB-Timber Compression, Steel Plate TB-HHS. HTM+ Continuous Beam Timber
m HTV + Verstarkter Holztrager
B5+ Reinforced Concrete Column
o Wil HOT1+ Timber Column
HTM-2 Biaxial

i STS+ Steel Column

TB-HHS (Timber Compression - Steel Plate)

HTM-S Stability
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Data entry - general operating instructions

The assistant is launched automatically when you start the program. You can enter quickly the most important
key figures of the structural system in the displayed window. These values can be edited subsequently in the
input section or on the graphical user interface.

Self-defined items can also be imported as templates. Saving as a template is done via » File » Save as
via » the option “Use as Template”.

Data entry via the assistant:
Loading uniaxial or biaxial
Type of timber
Material standard
Strenght class
Number of spans (or optionally, just a cantilever)
Span length
Cross section
Beam spacing
Permanent line load

Variable line load and type of action

Tip: You can use » File » Settings to change some basic settings for the assistant, color display or units of
measurement.

The graphical user interface is structured in such a way that all entered data can be

accessed directly in the graphics window. For example, dimensions or load values =@ I

can be directly clicked and changed. Other inputs acan be called up via the general

context menu (right-click on an empty graphic area) or via the context menus of the {hj\ inset cantilever on the left |
individual objects (span, support, load...) or via the interactive texts in the upper left T
corner. Spans and cantilevers can be added using the +/- icons on the right and left. 13 490

Moreover, you can move supports or loads that do not extend over the full length of
the beam with the mouse or by entering a coordinate value.

See also "interactive graphics" in the basic operating instructions.

Timber beam, DIN EM 1985:2013, Softwood C24, C5 constant 12720, with dead load -« |nteractive textlinks

CLLLUT LT VLT

3 [Span 1| [Span 2 |
o I,\\, View > v = o
@ Mew load Lt
Basic parameters
| Beam representation (Top edge flush) 500 |
= ALE e
|
| Stability longitudinal direction > 12 450 W.ZI
|
Input sections +
Show C5 Description Aff—— General context menu
Show beam designation (right mouskey)
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As in all Plus programs, the dimensional values are editable also in HTM+ and can be changed directly on the
graphic screen.

Tip: You can change the span length also by moving a support. To do this, click on the support using the left
mouse button and move the support while holding down the mouse button.

For each object (span, support, load, etc.) the
appropriate context functions are available.
These functions can be displayed via the Mew load
right mouse button and are, hence the name,
matched to the selected object.

View »

Basic parameters

Bearn representation (Top edge flush)
A general context menu is displayed when

= . . - Lo Bl i
no object is selected. In this menu, you will Stability longitudinal direction % contmeously supported
find functions such as load cases, settings Input sections at bearings

or visibility that are not relating to a Restrained in mid-span

Show C5 Description

particular graphical object, such as view restrained in 1/3 points

functions, stability, input sections, etc.. EIET B =TT

restrained in 1/4 points

restrained in distance x0

User-defined

The texts displayed in the top left section of the graphic screen are interactive as in all PLUS programs and
can be clicked on. This allows you to display dialogs in the graphic, which are otherwise only accessible via
the menu on the left. See also "interactive graphics" in the basic operating instructions.
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Basic parameters

Action effect
Standard (Norm)

accidental snow

Load factor for snow (A)

Average kmod for wind

w2 = 0.5 for snow (AE)

W2 for crane loads

uniaxial or biaxial (HTM-2 add-on).

definition of the design standard and its
national annex.

when you check this option, snow loads are
included as accidental action in addition to
the typical design situations.

this factor is used to determine the
accidental snow load related to its
characteristic value. This factor can be
freely specified (mark the option to enter the
value) or automatically determined by the
program.

If the option is selected, the modification
coefficient kmod for wind is used as the
mean value for the classes of the load
duration short and very short.

If the option is selected, the combination
coefficient g2 for the action of snow is
raised to a value of 0.5 in the earthquake
(AE) design situation.

(See introductory decrees of the federal
states (germany), e.g. Baden-Wirttemberg).

determines the combination coefficient p2
for crane loads (ratio of permanent share to
total crane load).

Properties n

Code and safety concept

4

Action effect Uniaxial

Morm

i

Biaial

accidental snow =T
Load factor for snow (4) 230
Awverage kmed for wind
w2 = 0.5 for snow (AE) O
w2 for crane loads. 0.90
Located in wind zone 3 or 4 O
equal v for permanent loads
Material o
Preselection Timber %
Timber Softwood b
Material code EN 338:2016 5
Strength class C24 *
Service class 2 b
Specific weight 420
Charact. bulk density 350
Hferage density pm | [ka/m7] 42

Located in wind zone 3 or 4 Select this option if the building is located in wind zone 3 or 4. In this case the
action 'snow' is not considered as an accompanying action to the leading action

Equal yG for permanent loads

Input of the material values for softwood, hardwood or glulam.
For the strength class user-defined values can be defined using
the F5 key. Furthermore, the service class and the density can be
set. The density is determined automatically depending on the

'wind'.

if this option is checked, all permanent loads or load cases are applied

together with the same partial safety factor (yG,sup or yG,inf), otherwise
permanent loads are combined independently with their lower and upper partial

safety factors.

Strength class

Service class

F5| c24
)' c14 T‘?
rR

selected wood strength, but can also be freely defined. raimie
. . . Freselection Timber
With DIN EN 1995: 2013 you first select timber / wood-based =
materials / STEICO via a preselection. Laminated veneer lumber M'm _rl : | Wood-based materials
(LVL22 C - LCL 80 P) and "STEICO" (LVL R, LVL RL, LVL Rs and ik STEICO
LVL X) are available.
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Structural system

You can enter spans / segments / cantilever arms / supports / joints
etc. directly in the graphic using the context menu or using a table
(tabs below the graphic).

Table - Spans / Segments

here the entire beam can be defined in
several parts (up to 4 parts). In the
Spans/Segments table, however, the
individual segments can be defined
differently - in this case "different" is
displayed here.

Multipart total beam

Rotation total beam as with multi-part design, the cross-
section rotation can be set for the entire
beam or under Spans/Segments for

individual segments.

Properties a
Basic parameters QD
Load
Design
..... Output
System 4]
Spans/Segmenis fothe tzbl= Bl (&
Multi-part totzl beam 1 ¥
Fotstion totzl beam Unmotated X
Systemaus final support & the third point of the support  ~
Beam spacing [m] 1.00
Supports to the t=bls EEE E|
Identical support geometry O
Equal K50
Ke30 1.00

. . Joints 2= &
System axis end support  the system axis of the end supports can T 2= 3
be in the third point or in the middle of the
side fixing ]
support.
) he b a0 is taken | " continuously supported ]
Beam spacing the eam spacing is taken into account i Gttty longiudinal trochion| mramsd s 173 poris =
calculation should include the affected = .
width (see "per beam" in the load table). smishes \mitainene's, —
Bottom edge flush [l
Table -> Supports i et <
Sections tothe tzble B
Identical support geometry o i
o ) . . ... about the system g
Ticking this option equates the width/depth of all supports.
Equal Kc90
Lateral pressure coefficient ke20 according to Eurocode X

By ticking this option, a line for entering a

common kc90 value is displayed. Otherwise,

this value can be defined directly in the table

(differently) for each support. 015

KC90 Lateral pressure coefficient kc90
according to Chapter 6.1.5 for the
verification of the bearing pressure.
Press the F5 key for a selection dialog
(Fig. Right).

015
175

Table - Joints

For members on continuous support with 11»=2h
(0125  with solid wood made of softwood
for glued laminated timber made of softwood

For cmembers on individual supports with 11> = 2h
with solid wood made of softwood

for glued laminated timber made of softwood, provided that | <= 400 mm
@free ke = |1

Cancel

Table - Cross sections

Explanation for the - Lateral restraints (stability analysis / HTM-S add-on)

Beam representation

In the case of different cross-sections, you can select between flush lower or upper edge for the graphic
representation. This setting has no influence on the calculation and is only used for graphic representation.

Table - Output sections
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Spans and cantilevers

Spans and cantilevers can be inserted/removed directly in the graphics window
using the +/- icons.

°©

. L . . . @j‘ inset cantilever on the left
After right-clicking on the span in the graphic (context menu), functions are T
available as they are also described for the tabular entry (below). For example, L‘l 4,90
the parameters for this span can be edited via "Properties".

]
=1
=1

Further input functions in the graphic

Joints or segments can also be inserted/deleted via the context menu and various other functions and some
quick templates are available.

=N+
oo % Mew load

Quick template ¥

] Insert section

4
JL" Duplicate 1

Copy
Delete

Mew joint
Mew field

Create cantilever arm on the left

edit field loads only ...
Cross-zection rotation (Unrotated) ¥

Multi-part (x1) ¥

convert to cantilever arm

Properties

Note: The other objects in the graphic (supports, loads, etc.) also have their own context menus, which you can
use to quickly access the desired function.

For graphical input in the PLUS programs, see also the Basic operating instructions-PLUS.
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Spans / Segments

To enter data via tables, click on the "Span/Segments" tab below the graphic screen. Use the buttons on the
right of the table to add or delete table rows.

| Spans/Segments | Supports ] Jaints: ] Cross-sections | Sections | Loads

Span Span length Segment Segment length C5-Na. Rotation Multipart Haunch
[m] [m] !
1 Cntle 0.00 1
2 Span 1 5.00 1 5.00(1. 12120 | Unrotated 1 O
3 Span 2 5.00 1 5.00|1. 12120 | Unrotated 1 [
4 Span 3 0.00 1
4] Cnt. i 0.00 1
Span automatic designation of the individual spans/cantilever arms. Activate a line by clicking.
Span length enter the length of the individual spans/cantilever arms.
Segment Consecutive segment numbering per span.

Segment length

CS-No.

Rotation

Multipart

Haunch

A span can be divided into several segments. As soon as you enter a section length smaller
than the span length, a new line is automatically inserted for the following segment with an
automatically adjusted remaining length. This segment can also be subdivided again in the
same way.

Tip: You can also make the division directly in the graphic using the context menu.

Each cross-section is identified with a serial number, followed by the cross-section

dimensions. To define a (new) cross section, click the edit button . Here you can define
a new cross-section in a separate dialog, whereby reinforcements timber/steel or
timber/timber are also possible.

To select an existing cross-section, simply click in the field and open the selection list.

The cross-section of each section can be rotated (0°/90°/180°/270°). A rotation of the entire
beam can be entered in the menu tree on the left.

The cross-section of each section can be defined in multiple parts (maximum of 4 cross
sections next to each other). To define the entire beam in multiple sections (all segments
are then defined with the same number of cross sections), enter this in the menu tree on the
left. In principle, two sections next to each other are treated as if there were 2 members with
one section each next to each other, each of which is subjected to half the load.

Tick this option to define a haunch for a span / cantilever / segment. An additional line is
automatically inserted under the corresponding span / segment in which you can specify the
cross-section at the right end.

il || e ||

Auf

it
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Supports

The bearing properties are called up by double-clicking on the support
or by right-clicking and selecting the appropriate option in the context
menu. In this section, it is also possible to delete supports or transfer
the properties of the support to another support using the "Copy
contents" function. Furthermore, the lateral restraints for the stability
analysis (HTM-S add-on) can be defined here. Alternatively, you can
also use the table ("Support” tab, see table entry below).

Transfer support reactions

Timber beam Softwood C24
£ ¥ 5 i

K
Ij} Copy content

Delete

l- Stability longrtudinal direction > F

T Transmit support reactions » ; ) 12
Properties [

The support loads can be transfered to the support programs B5 +, STS + and HO1 + as well as TB-HHS for
further calculation: Right-click on the support » Transmit support reactions » choose the program. See also

Qutput".

You can define supports in the z-direction (and for biaxial loading in the
y-direction) as well as for the torsion about the y-axis. In each case, you
can optionally define rigid supports or the enter a spring value.

Moreover, a column settlement can be pre-set for the individual
supports.

Kc90  Lateral pressure coefficient. See explanation under System.

Calculate spring values

Alternatively, also the spring values of a single column that can be
defined underneath and/or above the beam can be calculated by the
program and then be used for the beam calculation (click on the button
‘Calculate spring values’). In a separate dialog, tick the appropriate
options (Coil spring/Torsion spring) for the calculation and enter the
parameters. The spring values to be accepted (C, Phi) can also be
edited if necessary.

Properties of the support [1] ? x
Type
Type Direct bearing -
\afidth rect bearin:
Depth ITW beamg i
Ke30 1.00
Elastic bearing
Cz rigid B
Phiy [kNmirad] oo[]
Calculate spring values =
Endeinspannung [% 0.0
Settlement of supports
fz [cmd oo
Action -"E.-;—-.—.?e:'nerﬁs- 5

End clamping Clamping at end supports can be entered as a percentage.

If you do not use the graphic input (see above), click on the "Support" tab under the graphic to open the table

and enter the parameters there.

| Spans/Segments 7] Supports ] Joints ] Cross-sections | Sections ] Loads
Type Elastic bearing Settlement of supports
Type \width | Depth Cz Phiy Calculate | Endeinspannung | fz Action
[cm] [cm] [kMim] [kWNmirad] |spring values [%] [cm]
| | Direct bearing 120{ 120(  rigd 0ol g 00|  0.0|Settlements
=p 7 |Directbeaing ~| 120| 120 rigid oo ] 0.0 | Seftlements
el Direct bearing 120 120 rigid 0.0 g 00| 0.0 Settlements
Indirect bearing
FRILO Software GmbH 15.02.2024 Page 9
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Joints

In the graphic, you can select “new joint” in the context menu of a
span. The joint is displayed as a small circle in the span and you can
now enter the distance to the support in the dimension also shown

| Supports = Joints | | Cross-sections | Loads

in the graphic. l S :1] <
m
In the joint table, first click on the plus button to add a new line for 1 |Span 1 1 201
the joint, then select the desired span number and enter the .
. =» 2|Span2 p 000 &=
distance X1 to the left span start. 3 s
3 =

Cross-sections

Click on the "Cross-Sections" tab under the graphic.

You can define multiple cross-sections here. Cross-sections that are reinforced one-sided/both-sided can also
be selected (tabs timber/steel, timber/wood).

| Supporis 1 Joinls =7 Cross-sections | Loads | Sections
Ne Name | Wit Wb Fl |
[emd] e
11 12720 = BO0D BOO 00 Lok
2|2 | 1224 _?af 13820 52 1152 =

To define a new cross-section (new line), first click on the plus button.

Then call up the cross-section dialog via the edit button = ("Name" column). Various profiles and materials
can be selected for steel reinforcement, whereby the reinforcement can be arranged at the top/middle/bottom
(Position on the cross section...).

£ Management of the cross-sections - O pd
Own QS Wood construction  Wood/steel  Woodwood
Dimensions &y
Name of the cross section 10/16-UPE 140
Timber kemnel o
Thickness [em] 10.0
Height [em] 16.0
Timber core material Softwood C24 = 1 1
Steel enhancement (42
Section type |-Profile hd
Section series UPE -
Section 140 - | =
Position on the cross-section of the wood Mitte -
Matenal of reinforcement 5235 E’ |
Arrangement of reinforcement o
Selection Both sides - - . WU
EM S
Cinby right *

Further operating instructions for the cross-section dialog can be found in the document
Select - edit cross section - PLUS.
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Sections

User-defined output sections can be defined here. A table of characteristic

internal forces max/min is automatically generated for each action group.

Lateral restraints (stability)

| Crossseclions | Sections = | loads
Span x| [=
[mi |
= 1[Spani om| |*
|Cantilever left =
! NG . :

Timber beam 5oftwood C24

Using the context menu, you can also define the

L

E
-

L
12/20 i

restraints on the cross-section for the stability analysis H
(HTM-S add-on). b
Instead of a continuous restraint, the position of

restraints in the longitudinal direction of the beamand  _
on the cross-section can be defined. 4

Copy content
Delete

Stability longitudinal direction

Transmit support reactions

continuously supported
at bearings

Restrained in mid-span

Popperies restrained in 1/3 points
- at bearings (only on the supports) O\_’) restrained in 1/4 points
g 5 . :
- additionally, in the centre of the span " pestrineEbn st ance )
. . . User-defined
- in the third or quarter points of the spans
-atadistance of X0-  a uniform spacing can be specified here.
- user-defined free definition of restraints. Use the "Intermediate support” tab to specify the

distances of the restraints to the left-hand end of the beam or cantilever.

FRILO Software GmbH 15.02.2024
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Loads

Select first whether self-weight should be included in the calculation or not. The beam spacing is taken into account
if calculation should include the affected width (per beam). Via the ‘Loads’ tab, the load table is displayed.

Spans/Segments | Supporis ] Joints | Cross-sections ] Sections ] Loads

Reference Load type Action D L1 9.3 Wi W2 Unit | Factor | per beam | Span wise Acting Acting Designation
[m] Im] [m] . simultaneously | alternatively
1 | System Uniformly distributed load Permanent loads - —~ - 050 M kN/m 1.00 Ne none none
2 | System Uniformly distrbuted load  ~ | Cat. A: domestic, residental areas — - - 150 0 - kMN/m 1.00 Yes none none
lellpezowd:a\ulo;d e
Trapez.Load
Point load
Concentrated moment
Reference allows you to select whether distance A refers to the left end of
the beam (structural system) or to the left end of the Properties a
respective span. - Basic parameters af
. . L . L. System z
Load type selection of the load type: uniformly distributed, trapezoidal,
triangular, concentrated load or concentrated moments. :... Design
. . . ‘... Output
Action select an action from a list.
In the left menu you can also create / edit your own Settings
user-defined actions. Self-weight s =
D,L1/L2 D is the distance from the start of the load to the selected Beam spacing 1.00
reference (see above, left end of the beam for the system or Loads N
Ieft.end of the cantilever arm or f!eld). T e
L1 is the load length of a trapezoidal load. In the case of , ) -
I - . Simultanecus " [ =2l
triangular loads, the right and left lengths of the two triangular _
sections are specified via L1 and L2. i i
. . Description
Ww1/WwW2 entry of the load value (W1) or, in the case of a trapezoidal ST ”

load, also the second load value W2.

- . Alternat n =
A load value compilation can be called up using the "arrow il : L X B

N At 1
symbol” o érdd
Diescription
Note: check the loads in the graphic. Tip: Move the mouse pointer ot ot s ]
over a load value to view details. = - —
User defined actions (5 ]
H H 2 - n "
Unit line load (kN/m) or area load (kN/m?) - see column "per beam™.  _ . (1 available) |
Factor multiplication factor for the load ordinates e o
per beam by default, the option "per beam" is selected, i.e. the entered ... about the actions =

load (W1 /W2) is applied to this bar (for line loads, column unit

= kN/m) without taking the bar spacing into account.

If this option is deactivated (no tick), the beam spacing is taken into account. The load
ordinates are linked with this spacing and the load values are then calculated with the
affected width (for line loads, column unit = kN/m?2).

Spanwise you can choose whether loads that are entered over several spans shall apply span by
span or only in combination.

Acting simultaneously the loads of a simultaneous group always apply simultaneously.

Acting alternatively loads of an alternative group are always applied individually and are not superimposed. It
should be noted that with the additional selection "span-wise", each individual span with
this load is already considered as an alternative. If the load is defined as "not span-wise",
the entire load is set as an alternative to another load in the same alternative group.

Note simultaneous- / alternative groups: Select "New group" to create a group with a
consecutive index (Sim 1, Sim 2, etc.). You can also give descriptions to the groups in the
menu tree on the left, which will then appear in the printout.

Designation allows you to enter brief comments on the load. They are included in the output.
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User defined actions

In the left menu under “Load” you have the option to define and save your own actions ( “user-defined
actions”). Click the Edit button to bring up the following dialog.

Select Action

Name Id

onmen 9

My new Action 2 101 Name My new Action 1
Action Type Imposed load i
LDC middle %
Combination factors o
Combination cosfficient wl 0.700
Combination cosfficient wl 0.500
Combination cosfficient w2 0.300
Ultimate limit state (STR) (2]
upper PSF yF.sup 1.500
Limit state of equilibrium (EQU) (4]
upper PSF vF.sup 1.500
Limit state ground bearing capacity (GEQ) (2]
upper PSF yF.sup 1.300

| dladdacion || K Delete Action || Import Actions | | [} Export Actions j [ ok || Canced |

Add a new action

You can generate a new entry in the list using "Add action". Name the new action in the right-hand area (if the
name already exists, the program will automatically add an extension (*)). Change the parameters as desired
and confirm at the end of all entries with the OK button. A defined action can of course also be changed /
edited later - please mark the corresponding line in the list on the left.

Export/Import

You can export the list of actions as an * .act file and import it again into other programs.
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Design

In this section, you can optionally enable fire design and the oscillation analysis
and also control the shear stress analysis.

Fire design

Optional verification under fire exposure. The corresponding data-entry fields
‘Verification method’, ‘Fire resistance class’, ‘Charring all sides’ and ‘Charring
rates’ are displayed. If the "Calculate always simplified" option is selected, the
method with reduced cross-sections is always used for the verification procedure
for the fire design.

No reduction in stiffness

Depending on the selected standard (NA), the modulus of elasticity of
compression-loaded components is reduced by means of kdef in stability
verifications if the proportion of permanent loads in the total load is large. This
leads to smaller (less favorable) buckling coefficients kc.

No increase kl/kh

Specifies whether there should be no increase with the factor kl/kh.

Shear stresses

Consideration of the shear force when calculating the shear stress
Tau with red. Q = reduced shear force
- Tau with red. Q (support front edge)

- Tau with full Q = full shear force

Properties
- Basic parameters
.. System

Ultimate Limit State
Fire design

calculate always simplified
Fire resistance class
Charring all sides
Charring acc.to code
no reduction in stiffness
no increase ki'kh
Shear stresses
Vibration check
Vibration check
Serviceability

with shear defarmation
Check of cantilever
w,inst

w,net fin

w.fin

w,inst,cant.
w,net,fin.cant.

w fincant.

Remarks

... about the results

S

L

|
R 30 -
]
]
Tau with red. Q@ W
iz not provided. |
o
O
completely h
no check by sucking
completely
Ll 200[]
[ 1501
7] 1501
[ 100 ]
A
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You can select the oscillation analysis
on the "Design" tab.

B f this button allows you to
access the dialog for the oscillation
analysis.

Check the desired option for the
oscillation analysis.

Analysis in accordance with Hamm:

Hamm, P.; Richter, A.: Bemessungs- und
Konstruktionsregeln zum
Schwingungsnachweis von Holzdecken.
Symposia on timber construction 2009.
Leinfelden-Echterdingen.

Geometry and stiffness

- Beam spacing

- Width of the ceiling span
- Modal damping ratio Ksi
- Additional stiffnesses

- ELI

-Elg

Load specifications

Vibration check

Vibration

Provide check

Provide check acc to Hamm

Geometry and Stiffness

Beam spacing

‘width of the plate span

modal damping degree Ksi

Ksi

Calculate additional stiffness

Additional stiffness from the ceiling structure
Slab resistance perpendicular to the beam
Input of loads

Accept all system loads

Aditional Checks

Do not issue additional checks

Limitation of acceleration

beam spacing for area loads

ELI | [M ]
El.g | [MNm#m]

il
[mi

0.01 simple Planking

Well-being (0.1 m /82)

in a separate dialog, you can define the additional stiffnesses
displays the additional stiffness from the ceiling structure

displays the ceiling stiffness perpendicular to the beam

You can accept the system loads or optionally enter the loads manually (uncheck the box).

g0
qo

permanent area load

variable area load

You can select an action group in the selection list on the right.

Additional checks
Do not issue additional checks

Limitation of acceleration

- limitation of the speed of oscillation v caused by the unit pulse

Notes:
f resonance frequency
f>8 Hz:
- limitation of the deflection
f<8Hz

w
FS a mm/KN

special examinations at frequencies greater than 8 Hertz are not issued.

predefined limit values or self-defined limit value (for EN 1995)

in this case, the following requirements should be complied with for residential ceilings:

v<BED myNs?)

in this case, a separate examination should be carried out for residential ceilings.

In this connection, two additional verifications are performed that correspond to the approach

described in reference /1/.

/1/ BlaR, H. J. Erlauterungen zu DIN 1052-2004-08 , Bruderverlag March 2005
- limitation of the speed of oscillation v caused by footfall v<6- B(fl'c_l) m/(Ns2)

- limitation of the acceleration

8 <0,1 M/s*~0,4 m/s?

*

B |

1.00
0.00

001

0.0000
0.0000
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You can optionally take deformation by shear into account.

Furthermore, data-entry fields for the limit values (LV) of the deformations are available in this section:

w inst,cantil LV of the elastic deflection of a cantilever beam

w,netfincantil LV of the summarized elastic deflection and creep deformation of a single cantilever

w fin,cantil LV of the final deformation of a cantilever

w,inst LV of the elastic deflection of a single-span girder

w,netfin LV of the summarized elastic deflection and creep deformation of a single-span girder
w,fin LV of the final deformation of a single-span girder

You can use the "Sections" tab to define output sections by specifying the
span and a distance X to the start of the span on the left (click + button for
a new entry).

Graphic input

You can also create several sections (mouse clicks) directly in the graphic
using the context menu (right mouse button, input sections). The position
can be shifted appropriately with the mouse. Confirm / finish the entry with
aright click.

The sections are shown as symbols in the graphic and can also be moved
later.

The sections can be shown / hidden in the result graphics.

tions

_.

[FER %]

| Loads | 3] Sections

Span x
[m]
Span 1 1.50
Span 2 200
Span 1 0.00
Cantilever left
S 2

Bl || b || B

¥ || Aol
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O Utp Ut Properties 2

Q&
Scope of output / Calculation / Results
Before starting the output, click on the calculation icon if the option : —
‘automatic calculation after each input’ is switched off ("Auto off'/"Auto ~ CUtpPut settings 4
on" icon). Output scope Bricf ¥
. - . . Mot 7
After the calculation, the load is displayed in the bottom right-hand = zs : =
. . . . Y o
corner of the graphics window and provides a good overview of the i il
efficiency of the structural system entered. De<aptioaoticads dabiitad T
Graphical o
Scale system image Face width i
Graphic of used cross-sections [
In the upper toolbar, the individual representations in the graphic can be  Resuit= o
switched on or off. Structural safety per cross section
Internal forces Graphics
Structural safety Il
All sections
The Load filter button can be used to filter loads according to actions Def . .
. . . R ormation Graphics ez
and groupings (alternative / simultaneous). The selection is then Usability O
highlighted visually / in color in the graphic. In this way loads can be S — : =
checked clearly and edited in the graphic. The filter is canceled again P © _ar_':erla .'0" O
with "Deactivate". b ki
Design values O
Output per [m]
Decisive Combination O

Via the ‘Results’ tab, you can display the different result graphs.

The defined output sections can be shown and hidden.

You can use the camera symbol to take a snapshot of the displayed graphic and give it a name. Use the right
icon to display the list of recordings that can also be deleted here. These images are automatically included in
the output.

Hlﬁ D E} L r (¥ W = Mew item (Project: Localization)* - HTM+ Continuous Bearn Timber 02/21A-Beta (prerelease)
File Start Results & @Hep~
[ — ! ! f e
5 s 3 Sz T] rr] r}] ) QJ“ o
Makitritr olfizaiion M- Q- V- n.Bending n.shear Sections
Area Area Area
Situation Internal forces | Deformation Design Sections | Snapshots ~

By checking the desired options, you can determine the scope of data to be put out. You can also define
Output sections.

Via the Document tab, you can displays the document in PDF and print it.

See also Output and printing
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Manual HTM+

Transfer of support reactions

The support loads can be forwarded to the support programs B5+, Timber beam Softwood C24
STS+ and HO1+ as well as TB-Timber Compression, Steel Plate ¥ ¥ ¥ o0
TB-HHS for further calculation: -bi\’ ﬁ
Copy content

Right-click on the support » Transmit support reactions » choose Delete
the program.

" . X . N = Stability lengitudinal direction L i
See also connected programs under "Application options". J | 2

| Transmit support reactions > 1T

in
=

Properties
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